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1. Introduction to additive manufacturing  
 

  History of additive manufacturing 

 Additive manufacturing workflow  

 Introduction to AM technologies  
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Introduction to AM technologies 
 

 The term Additive Manufacturing is also 

called 3D printing.  

These technologies can be used with a wide 

range of different materials, such as metal, 

plastic, ceramic and wax to produce ready 

made products based on a CAD file.  

The products are built up layer by layer in the 

AM machine by melting, welding or gluing 

thin layers of powder together, hardening 

liquid using UV light, or melting thin plastic 

wires together [1]. 
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 Additive manufacturing technologies 
Additive manufacturing technologies are used to build parts by 

depositing the material in successive layers based on the 3D drawing 

of the parts. 
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History of additive manufacturing 
 

1980: Selective laser sintering   

by Carl Deckard 

1984: Stereolithography  

 by Chuck Hull 

1987: Digital Light Processing  

 by Larry Hornbeck 

1988: Fused Deposition Modeling  

by  S. Scott Crump 

1989: Fused Deposition Modeling   

By Scott Crump 
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Additive manufacturing workflow  

 Create the model 

• method for producing a digital model:  computer-aided 
design (CAD) or reverse engineering via 3D scanning 

Identification and select  AM  technology 

• depending on the characteristics of the part, quality and 
delivery time 

Pre Processing   

• convert a 3D CAD file into instructions, AM guidelines, 
process limitations 

Sample Parts 

• characteristics part can be checked ,  the design or the 
manufacturing settings can change according to desired 
properties, optimization of the design feature 

 Manufacturing process 
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Producing a digital model 
 

CAD design software for designing parts: 
 

• SOLIDWORKS  https://www.solidworks.com/ 

• FUSION 360 https://www.autodesk.com/products/fusion-360 

• RHINOCEROS https://www.rhino3d.com/  

• SIMPLIFY3D https://www.simplify3d.com/  

• ONSHAPE https://www.onshape.com/  

• CURA https://ultimaker.com/software/ultimaker-cura 

• NETFABB https://www.autodesk.com/products/netfabb  

https://www.solidworks.com/
https://www.autodesk.com/products/fusion-360
https://www.autodesk.com/products/fusion-360
https://www.autodesk.com/products/fusion-360
https://www.rhino3d.com/
https://www.simplify3d.com/
https://www.onshape.com/
https://ultimaker.com/software/ultimaker-cura
https://ultimaker.com/software/ultimaker-cura
https://ultimaker.com/software/ultimaker-cura
https://www.autodesk.com/products/netfabb
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STL (Standard Triangle Language) conversion 
 

The  CAD software allows to export  file format into STL [2].  

 

 
Software Description 

Solidworks 
 

File > Save As... Set Save As... file type to STL Options > Resolution > Fine (or Custom) > OK  

3DS Max 
 

3DS Max Application Menu > Export > StereoLitho (*.STL)  

AutoCAD 
 

Output > Send panel > Export At the Command prompt, enter export. In the Export Data dialog box, 

enter a filename. Under Files of Type, select Lithography (*.stl) and click Save. Select one or more 

solid objects. Note: The XYZ coordinates of all objects must be above zero. The file extension .stl is 
automatically appended to the file name.  

Fusion 360 
 

File > 3D Print Under Refinement / Refinement options, select export settings. Output > untick “Send 
to 3D Print Utility” > OK > Save  

Inventor 
 

File > Print > 3D Print Preview Save Copy As... (top left of window) > Save  

Onshape 
 

Right click on [Part Name] on bottom right > Export Under Format, select STL. Specify model units. 
Select export settings.  

PTC Creo 
 

File > Save As... > Save a Copy Change Type to Stereolithography (*.stl). Click OK > a new Export 
STL dialog will open. Under Deviation Control, change export settings.  

Rhino 
 

File > Save As… In the Save As... box, select Stereolithography [*.stl].  

Sketchup 
 

Download Sketchup to DXF or STL plugin. Start Sketchup. Tools > Export to DXF or STL  

Solid Edge 
 

File > Save As... Set Save As... file type to STL. Options > Select export options  

ZBrush 
 

Use Decimation Master to appropriately reduce the polygon count. Zplugin > 3D Print Hub > Export 
as STL.  
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 Convert a CAD model to an STL file in Inventor 
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Printing 
 

The machine will follow an automatic 

process and generally problems will occur 

only when the machine runs out of 

material or there is a software error. 
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Post processing 
 

SLA requires a component to cure 

under UV before handling. 

Metal parts often need to be stress 

relieved in an oven . 

FDM parts can be handled right away. 

For technologies that utilize support, 

this is also removed at the post-

processing stage.  

Most 3D printing materials are able to 

be sanded and other post-processing 

techniques including tumbling, high-

pressure air cleaning, polishing, and 

coloring are implemented to prepare a 

print for end use [2]. 
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Additive Manufacturing benefits  
 

 AM technologies are fast, precise and flexible form of 

production.  

 There are not geometric limitations. 

 Single step manufacture 

 Complexity and design freedom 

 Reduce  waste production 

 Save  on energy costs 

 Reduce  the time-to-market 

Posted on 13 May 2015 by Jonny Williamson 

https://www.themanufacturer.com/articles/illustrating-the-real-world-benefits-of-additive-manufacturing/
https://www.themanufacturer.com/author/jonny-williamson/
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2. Additive Manufacturing (AM) processes  

 
Type of Additive Manufacturing (AM) processes according to  

ISO/ASTM52900-15 :  

 vat photopolymerization 

 material extrusion    

 powder bed fusion   

 material jetting   

 binder jetting   

 sheet lamination  

 directed energy deposition. 
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Additive manufacturing technologies 

 
• Stereolithography (SLA) 

• Direct Light Processing (DLP) 

• Continuous DLP (CDLP)   

Photopolymerization 

Additive manufacturing process in which liquid 
photopolymer in a vat is selectively cured by light 

activated polymerization 

• Selective Laser Sintering (SLS)  

• Selective Laser Melting (SLM)  

• Direct Metal Laser Sintering (DMLS) 

• Electron Beam Melting (EBM) 

• Multi Jet Fusion (MJF) 

Powder Bed Fusion 

Process in which thermal energy selectively fuses regions 
of a powder bed 

• Fused Deposition Modeling (FDM)  

Material Extrusion 

Process in which material is selectively dispensed through 
a nozzle. 

• Material Jetting 

• Nano particle jetting 

• Drop-On-Demand   

Material Jetting 

Process in which material  droplets o build material are 
selectively deposited.  
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• Additive manufacturing technologies 

 
• Binder Jetting  

Binder Jetting 

 Process in which a liquid bonding agent is selectively 
deposited to join powder materials. 

 

• Laser Engineered Net Shape   

• Electron Beam Additive Manufacture   

 

 

Direct Energy Deposition 

 Process in which focused thermal energy is used to fuser 
material by melting as they are being deposited. 
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Stereolithography (SLA)  
The part is created by selectively curing a polymer resin layer-by-

layer using an ultraviolet (UV) laser beam.  
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Components of the stereolithography 

Source: Manufactur3DMag.com 
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SLA fabrication process steps [2] 

 

• The build platform is first positioned in the tank of liquid 

photopolymer, at a distance of one-layer height for the surface of 

the liquid. 

• Then a UV laser creates the next layer by selectively curing and 

solidifying the photopolymer resin. The laser beam is focused in 

the predetermined path using a set of mirrors. The whole cross-

sectional area of the model is scanned, so the produced part is 

fully solid. 

• When a layer is finished, the platform moves at a safe distance 

and the sweeper blade re-coats the surface. The process then 

repeats until the part is complete. 

• After printing, the part is in a green, no-fully-cured state and 

requires further post processing under UV light if very high 

mechanical and thermal properties are required. 
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Objects printed through stereolithography 

Source: Engitype.com  
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Stereolithography: Pros and Cons [3] 

Pros 
 SLA is one of the most precise 3D 

printing techniques on the market. 

 Prototypes can be created with 

extremely high quality, with finely 

detailed features (thin walls, sharp 

corners, etc…) and complex geometrical 

shapes. Layer thicknesses can be made 

as low as 25 μm, with minimum feature 

sizes between 50 and 250 μm. 

 SLA provides the tightest dimensional 

tolerances of any rapid prototyping or 

additive manufacturing technology: +/- 

0.005″ (0.127 mm) for the first inch, and 

an additional 0.002″ for each additional 

inch. 

 Print surfaces are smooth. 

 Build volumes can be as high as 50 x 50 

x 60 cm³ without sacrificing precision. 

Cons 
 Printing tends to take a long time. 

 Steep slopes and overhangs require 

support structures during the building 

process. Such parts may potentially 

collapse during printing or curing 

phases. 

 Resins are comparatively fragile and 

therefore not suitable for functional 

prototypes or mechanical testing. 

 SLA offers limited material and color 

choice, usually offering black, white, 

grey and clear material. Resins are 

oftentimes proprietary and therefore 

cannot be easily exchanged between 

printers from different brands. 

 SLA printing costs are comparatively 

high (e.g. machine, materials)  
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Direct Light Processing (DLP)  
 

Direct Light Processing (DLP) uses a digital light projector screen 

to flash a single image of each layer all at once.  

It was originally developed in 1987 by Larry Hornbeck of Texas 

Instruments 

Because the projector is a digital screen, the image of each layer is 

composed of square pixels, resulting in a layer formed from small 

rectangular bricks called voxels. 
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Components of the Direct Light Processing 
 

The main components of a DLP 3D printer are the following: digital 

light projector screen, DMD, vat (resin tank), the build plate and the 

elevator for the build plate 



A
d
d
it
iv

e
 M

a
n
u
fa

c
tu

ri
n
g

 
 UPenAUTO 

UPenAUTO : 2017-1-ES01-KA203-03858 

Digital Light Processing process steps [4] 
 

• Objects are built in a shallow container with a transparent 

bottom filled with liquid photopolymer, which is a plastic that 

responds to light. An adjustable building platform is initially 

placed in its lowest position closest to the bottom of the 

container. A projector projects the cross section of the detail 

through the transparent base of the container, which solidifies a 

single layer of the photopolymer. 

• The platform with the solidified is then lifted so that a new thin 

layer of fhotopolymer is filled against the bottom of the vessel. 

The projection is repeated with a new cross section which builds 

on the previous cross section. 

• Support structures can be created if the fluid can not support the 

weight of the component's overhanging parts. 

• The cycle is repeated until the entire 3D object is created after 

which it is cleared of any support structures and cured in a UV 

oven. 
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Object  printed through Direct Light Processing  

source: 3D Hubs 
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Digital Light Processing: Pros and Cons [5] 

Pros 
 Smooth (at 1080p resolution), jitter-free 

images. 

 Perfect geometry and excellent grayscale 

linearity achievable. 

 Usually excellent ANSI contrast. 

 The light source is more-easily replaceable 

than the backlights used with LCDs, and 

on DLPs is often user-replaceable. 

 The light from the projected image is not 

inherently polarized. 

 New LED and laser DLP display systems 

more or less eliminate the need for lamp 

replacement. 

 DLP offers affordable 3D projection display 

from a single unit and can be used with 

both active and passive 3D solutions. 

 Lighter weight than LCD and plasma 

televisions. 

 are  not limited in size by their inherent 

mirror mechanisms,   

 DLP projectors can process up to seven 

separate colors, giving them a wider color 

gamut. 

Cons 

 Some viewers are bothered by the 

"rainbow effect" present in colour-wheel 

models - particularly in older models 

(explained above).   

 Rear projection DLP TVs are not as thin as 

LCD or plasma flat-panel displays   

 Replacement of the lamp / light bulb in 

lamp-based units.   

 Dithering noise may be noticeable, 

especially in dark image areas.   

 Error-diffusion artifacts caused by 

averaging a shade over different pixels, 

since one pixel cannot render the shade 

exactly 

 Response time in video games may be 

affected by upscaling lag  

 Reduced viewing angle as compared to 

direct-view technologies such as CRT, 

plasma, and LCD 

 May use more electricity, and generate 

more heat, than competing technologies. 
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Selective Laser Melting (SLM)  
Selective Laser Melting  use a laser beam to fuse metal powder layer 

by layer.  

SLM works on the principle of melting.  Melting actually creates a pool 

where the materials can consolidate before reforming and hardening to 

create new solid structure.   
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Components of SLM 
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SLM process steps  
 

• Selective laser melting uses a laser 

to melt successive layers of 

metallic powder. 

• The laser will heat particles in 

specified places on a bed of 

metallic powder until completely 

melted. The CAD 3D file dictates 

where melting will occur. 

• Then, the machine will 

successively add another bed of 

powder above the melted layer, 

until the object is completely 

finished. 
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• Objects printed through SLM 

 

Source: Appliancedesig 
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SLM Pros and Cons 

 

 
Pros 

 Possibility of making several parts at the 
same time 

 Possibility of making different designs in 
the same batch 

 Automatic process 

 Manufacturing of parts that cannot be 
machined 

 High resolution 

Cons 
 Expensive, especially if parts aren’t 

optimized or designed for the process 

 Specialized design and manufacturing 

skills and knowledge needed 

 Limited currently to relatively small 

parts 

 Rough surface finish 

 Lots of post-processing required 
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Selective Laser Sintering (SLS) 
 

Selective Laser Sintering (SLS)  produces solid plastic parts 

using a laser to sinter thin layers of powdered material one layer at 

a time. 

 

Source: EOS 
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Components of the Selective Laser Sintering   
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Selective Laser Sintering process 

steps  
 

Steps in SLS [2] 

• I. The powder bin and the build area are first heated just below 

the melting temperature of the polymer and a recoating blade 

spreads a thin layer of powder over the build platform. 

• II. A CO2 laser then scans the contour of the next layer and 

selectively sinters (fuses together) the particles of the polymer 

powder. The entire cross section of the component is scanned, 

so the part is built solid. 

• III. When the layer is complete, the build platform moves 

downwards and the blade re-coats the surface. The process 

then repeats until the whole part is complete. 
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Objects printed through SLS 
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SLS Pros and Cons [2] 

Pros 

 SLS parts have good, isotropic 

mechanical properties, making them 

ideal for functional parts and 

prototypes. 

 SLS requires no support, so designs 

with complex geometries can be 

easily produced. 

 The manufacturing capabilities of 

SLS is excellent for small to medium 

batch production 

Cons 
 Only industrial SLS systems are 

currently widely available, so lead times 

are longer than other 3D printing 

technologies, such as FDM and SLA. 

 SLS parts have a grainy surface finish 

and internal porosity that may require 

post processing, if a smooth surface or 

watertightness are required. 

 Large flat surfaces and small holes 

cannot be printed accurately with SLS, 

as they are susceptible to warping and 

oversitnering. 
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Direct Metal Laser Sintering (DMLS) 
 

Direct Metal Laser Sintering use the laser what shape to ‘print’, 

moving across the powder to trace a cross-section of the product.  
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Components of the DLMS 
 

https://4.bp.blogspot.com/-NuzNjhNJwdc/WIddNdRLXhI/AAAAAAAAFbs/H_tRPY-b3h8fLgLXTrWowJU92x7A26y8gCLcB/s1600/Direct+Metal+Laser+Sintering+Services.jpg
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DMLS process steps  
DMLS is used exclusively with metal and metal alloys.  

DMLS melts down thin layers of metal powder with an electronically 

driven laser beam. 

The metal sintering or melting process fuses the powder together 

and creates a solid form. Once this first layer has been established, 

the printer platform drops, typically by no more than 0.1mm to 

expose a new layer of powder and the whole process of first 

tracing, then heating begins again. 
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• Objects printed through DMLS 

 



A
d
d
it
iv

e
 M

a
n
u
fa

c
tu

ri
n
g

 
 UPenAUTO 

UPenAUTO : 2017-1-ES01-KA203-03858 

• DMLS Pros and Cons 

Pros 
 objects are created by an easy and 

completely automatic procedure 

 The technology allows the creation of 

very complex geometries that cannot 

be produced by machining  

 Parts can be finished with 

conventional polishing techniques, 

Cons 
 Costs   of a DMLS Machine are very 

high. 

 Not suitable for large production runs. 

 Not cost effective for ‘simple’ 

engineered products. 

 The density of the final metal 

component, is likely to be lower than 

one manufactured through 

conventional engineering processes. 

 Laser manufacture requires high 

levels of energy consumption. 

 The finished component may have a 

level of porosity, allowing liquids and 

gases to be absorbed. 
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Electron Beam Melting (EBM) 
EBM  technology uses an electron beam produced by an electron gun 

to fuse metal particles and create, layer by layer, the desired part.  

 

 

 

Source: Arcam 
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Components of the EBM 
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EBM process  
 

EBM 3D printers consist of an 

energy source capable of emitting 

the electron beam, a powder 

container, a powder feeder, a 

powder re-coater, and a heated 

build platform.  

The printing process must take 

place in a vacuum. That’s because 

electrons of the electron beam 

would otherwise collide with gas 

molecules, which would “kill” the 

electron beam.   
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• Objects printed through EBM 

Source: Arcam 
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EBM Pros and Cons 

Pros 
 Geometric freedom for 

engineering product designers 

 Minimum material waste 

 Less tooling and set up costs 

 Residual stress reduction due to 

increased process temperature 

 Oxidation reduction due to 

vacuum environment 

Cons 

 Commercially available material are 

limited 

 Surface finish similar to sand 

casting 

 Needs full understanding to get the 

full benefit of the process 
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Multi Jet Fusion (MJF) 
MJF is a powder-based 3d printing process that uses inkjet  to 

deposit fusing and detailing agents to control voxels that are then 

fused into a solid layer then repeated until the build is complete [7]. 
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Components of MJF 
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MJF process 
 

The fabrication process begins by laying down a thin layer of 

material in the build space.  

A carriage containing the  thermal inkjet array passes from right-to-

left, depositing chemical agents across the full working area. These 

chemical agents are actually two; one is a fusing agent, to create a 

solid layer from the material, and the other is a detailing agent, to 

determine the physical outline of the layer being created.  

Energy is applied to catalyze the fusing agent, and the powder 

imbued with the detailing agent remains inert [8].   
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• Objects printed through MJF 

Source: HP   
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• MJF: Pros and Cons 

Pros 
 Very high accuracy and 

resolution 

 Parts exceptionally strong 

and virtually isotropic 

 Extremely fast and cost 

efficient 

Cons 
 Surface quality is good, but rougher 

than that produced by photopolymer-

based technologies 

(Stereolithography, Polyjet). 

 The raw parts are grey; these parts 

can easily be dyed black, but other 

colors require coating (at extra cost). 

 Only some materials are available 
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• Fused Deposition Modeling (FDM)  
 

FDM  process constructs three-dimensional objects directly from 

3D CAD data. A temperature-controlled head extrudes 

thermoplastic material layer by layer. 
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Components of FDM 
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FDM process   
FDM begins with a software process, developed byStratasys, which 

processes an STL file (stereolithography file format) in minutes, 

mathematically slicing and orienting the model for the build 

process. If required, support structures are automatically generated. 

The machine dispenses two materials – one for the model and one 

for a disposable support structure [9]. 

The thermoplastics are liquefied and deposited by an extrusion 

head, which follows a tool-path defined by the CAD file [9]. 

A plastic filament or metal wire is unwound from a coil and supplies 

material to an extrusion nozzle which can turn the flow on and off. 

The nozzle is heated to melt the material and can be moved in both 

horizontal and vertical directions by a numerically controlled 

mechanism, directly controlled by a computer-aided 

manufacturing(CAM) software package [9]. 
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• Objects printed through FDM 
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3. Materials  
 

Criteria to choose a materials for AM 
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Find the right material  
 

OptiMatter provides a wide range of data on materials, technologies 

and parameters and calculates the best printing configuration based 

on the user’s requirements. https://www.optimatter.com  

 

https://www.optimatter.com/
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The main materials used in SLA [2] 

 

Resin Description 

Standard resin 
High-detail resin that produces parts with a smooth, injection mold-like 

surface finish. It is brittle and used for non-functional parts. 

Clear resin Has a semi-transparent appearance 

Tough resin (ABS-like) 
Has properties of ABS and produces parts with improved mechanical 

properties compared to standard resin. Can be used for functional parts. 

Durable resin (PP-like) 
Semi-flexible, ideal for snap fit assemblies and high-detail durable 

prototypes. 

Rubber-like resin 
Rubber-like feel and shore hardness < 70A that can be compressed and 

bent. Lacks the performance of true rubber. 

Heat-resistant resin Has high stiffness and excellent temperature resistance. 

Castable resin 
High-detail resin used to produces patterns for investment casting. They 

burn out cleanly with no ash or residue. 
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The main materials used in SLS [2] 

 
Material Description 

Nylon 12 (PA 12) 

SLS nylon is a robust thermoplastic 

with all-around excellent physical 

properties, ideal for functional 

prototypes and end-use applications. 

Glass-filled Nylon (PA 12 GF) 

Glass-filled SLS nylon is reinforced 

with glass beads creating parts with 

higher stiffness and thermal stability 

than standard nylon. 

TPU / TPE / TPA * 

Thermoplastic elastomers combine 

high elasticity and strength with good 

chemical resistance, making them 

ideal for functional, flexible parts. 
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DMLS MATERIALS [6] 

Materials Alloy Designation Layers Hardness Advantages Applications 

Stainless Steel (PH1) 
15-5 PH, DIN 1.4540 

and UNS S15500 
20 or 40 Micron Layers 

30-35 HRC Built, Post 

Hardened to 40 HRC 

High Hardness & 

Strength 

Prototype / Production 

Parts 

Stainless Steel (GP1) 

17-4, European 

1.4542, German 

X5CrNiCuNb16-4 

20 or 40 Micron Layers 

230 ± 20 HV1 Built, 

Ground & Polished to 

250-400 HV1 

High Toughness & 

Ductility 

Engineering 

Applications 

Cobalt Chrome (MP1) 

(Cobalt Chromium) 

ISO 5832-4 and ASTM 

F75 

20, 40 or 50 Micron 

Layers 
35-45 HRC Built 

High Temperature 

Resistance 

Turbines & Engine 

Parts 

Maraging Steel (MS1) 

18% Ni Maraging 300, 

European 1.2709, 

German X3NiCoMoTi 

18-9-5 

20 or 40 Micron Layers 

33-37 HRC Built, Post 

Hardened to 50-56 

HRC 

Easily Machinable & 

Excellent Polishability 

Injection Molding 

Tooling, Conformal 

Cooling 

Aluminium AlSi10Mg Typical Casting Alloy 30 Micron Layers Approx 119 ± 5 HBW 
Low Weight, Good 

Thermal Properties 
Automotive, Racing 

NickelAlloy IN718 

(Inconel 718) 

UNS N07718, AMS 

5662, AMS 5664, W.Nr 

2.4668, DIN 

NiCr19Fe19NbMo3 

40 Micron Layers 
30 HRC Built, Post 

Hardened 47 HRC 

Heat & Corrosion 

Resistant 

Turbines, Rockets, 

Aerospace 

Stainless Steel (316L) ASTM F138 20 Micron Layers 85 HRB 
Corrosion & Pitting 

Resitant 

Surgical Tools, Food & 

Chemical Plants 

Titanium Ti-64 * ASTM F2924 30 or 60 Micron Layers 320 ± 15 HV5 

Light Weight, High 

Strength, Corrosion 

resistance 

Aerospace, Motorsport 

Racing 

Titanium Ti-64 ELI * ASTM F136 Properties 30 or 60 Micron Layers 320 ± 15 HV5 
Corrosion Resistance, 

Biocompatibility 

Medical, Biomedical, 

Implants 

https://gpiprototype.com/pdf/EOS-StainlessSteel-PH1.pdf
https://gpiprototype.com/pdf/EOS_StainlessSteel-GP1_en.pdf
https://gpiprototype.com/pdf/EOS_CobaltChrome_MP1_en.pdf
https://gpiprototype.com/pdf/EOS_CobaltChrome_MP1_en.pdf
https://gpiprototype.com/pdf/EOS_MaragingSteel_MS1_en.pdf
https://gpiprototype.com/pdf/EOS_Aluminium_AlSi10Mg_en.pdf
https://gpiprototype.com/pdf/EOS_NickelAlloy_IN718_en.pdf
https://gpiprototype.com/pdf/EOS_NickelAlloy_IN718_en.pdf
https://gpiprototype.com/pdf/EOS_Stainless_Steel_316L_en.pdf
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• FDM materials [10] 
MATERIALS DESCRIPTION 

TPU  

(thermoplastic 

polyurethane 
elastomer) 

 Accurate elastomer parts with high elongation 

 Superior toughness and abrasion resistance 

 Wide variety of applications including flexible hoses, tubes, air ducts and vibration 
dampeners 

Antero™ 800NA  

(polyetherketoneketo
ne) 

 High heat and chemical resistance 

 Low outgassing and high dimensional stability 
 Excellent strength, toughness and wear-resistant properties 

ULTEM™ 1010 resin 
(polyetherimide) 

 Food safety and bio-compatibility certification 

 Highest heat resistance, chemical resistance and tensile strength 
 Outstanding strength and thermal stability 

ULTEM 9085 resin 
(polyetherimide) 

 FST (flame, smoke, toxicity)-certified thermoplastic 

 High heat and chemical resistance; highest flexural strength 
 Ideal for commercial transportation applications such as airplanes, buses, trains and boats 

FDM Nylon 12™ 
(polyamide 12) 

 The toughest nylon in additive manufacturing 

 Excellent for repetitive snap fits, press fit inserts and fatigue-resistance applications 
 Simple, clean process – free of powders 

FDM Nylon 12CF™ 
(polyamide 12CF) 

 Carbon-filled thermoplastic with excellent structural characteristics 

 Highest flexural strength 
 Highest stiffness-to-weight ratio 

PC 
(polycarbonate) 

 Most widely used industrial thermoplastic with superior mechanical properties and heat 

resistance 

 Accurate, durable and stable for strong parts, patterns for metal bending and composite 

work 
 Great for demanding prototyping needs, tooling and fixtures 
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4. AM Application 
  

More information about AM application can be found on the following 

videos. 

 

 
AM 

process 

Source 

DMLS https://www.youtube.com/watch?time_continue=3&v=P

HaXX2OoOs4&feature=emb_logo 

EDM https://www.youtube.com/watch?time_continue=89&v=

M_qSnjKN7f8&feature=emb_logo 

MJF https://www.youtube.com/watch?v=DdAocUqrFts&list=P

LoMwRIIUViGQsA-

49cKLGZ62iX4MmWrXb&index=88&app=desktop 

FDM https://www.youtube.com/watch?v=WHO6G67GJbM 

SLA https://www.youtube.com/watch?v=yW4EbCWaJHE 

DPL https://www.youtube.com/watch?v=9nb8mM3uEIc 

SLM https://www.youtube.com/watch?v=R5WCyafMPLs  

SLS https://www.youtube.com/watch?v=9E5MfBAV_tA  

https://www.youtube.com/watch?v=DdAocUqrFts&list=PLoMwRIIUViGQsA-49cKLGZ62iX4MmWrXb&index=88&app=desktop
https://www.youtube.com/watch?v=DdAocUqrFts&list=PLoMwRIIUViGQsA-49cKLGZ62iX4MmWrXb&index=88&app=desktop
https://www.youtube.com/watch?v=DdAocUqrFts&list=PLoMwRIIUViGQsA-49cKLGZ62iX4MmWrXb&index=88&app=desktop
https://www.youtube.com/watch?v=DdAocUqrFts&list=PLoMwRIIUViGQsA-49cKLGZ62iX4MmWrXb&index=88&app=desktop
https://www.youtube.com/watch?v=WHO6G67GJbM
https://www.youtube.com/watch?v=yW4EbCWaJHE
https://www.youtube.com/watch?v=9nb8mM3uEIc
https://www.youtube.com/watch?v=R5WCyafMPLs
https://www.youtube.com/watch?v=9E5MfBAV_tA


A
d
d
it
iv

e
 M

a
n
u
fa

c
tu

ri
n
g

 
 UPenAUTO 

UPenAUTO : 2017-1-ES01-KA203-03858 

References 
1. https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4. 

2. https://www.3dhubs.com  

3. https://all3dp.com/2/stereolithography-3d-printing-simply-explained/ 

4. https://www. manufacturingguide.com/en/digital-light-processing-dlp  

5. https://en.wikipedia.org/wiki/Digital_Light_Processing 

6. https://gpiprototype.com/dmls-direct-metal-laser-sintering 

7. https://www.tth.com/3d-printing/multi-jet-fusion-mjf/ 

8. https://all3dp.com/multi-jet-fusion/  

9. https://www.iitk.ac.in/dordold/index.php?option=com_content&view=category&layout=blog&id=2

00&Itemid=219  

10. https://studiofathom.com/fused-deposition-modeling-fdm  

https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.dti.dk/specialists/introduction-to-additive-manufacturing/am-technologies/40476,4
https://www.3dhubs.com/
https://www/
https://en.wikipedia.org/wiki/Digital_Light_Processing
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://gpiprototype.com/dmls-direct-metal-laser-sintering
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://www.tth.com/3d-printing/multi-jet-fusion-mjf/
https://all3dp.com/multi-jet-fusion/
https://all3dp.com/multi-jet-fusion/
https://all3dp.com/multi-jet-fusion/
https://all3dp.com/multi-jet-fusion/
https://all3dp.com/multi-jet-fusion/
https://www.iitk.ac.in/dordold/index.php?option=com_content&view=category&layout=blog&id=200&Itemid=219
https://www.iitk.ac.in/dordold/index.php?option=com_content&view=category&layout=blog&id=200&Itemid=219
https://studiofathom.com/fused-deposition-modeling-fdm
https://studiofathom.com/fused-deposition-modeling-fdm
https://studiofathom.com/fused-deposition-modeling-fdm
https://studiofathom.com/fused-deposition-modeling-fdm
https://studiofathom.com/fused-deposition-modeling-fdm
https://studiofathom.com/fused-deposition-modeling-fdm
https://studiofathom.com/fused-deposition-modeling-fdm

